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NEW QUESTION 1
- (Topic 3)
Which feature helps to automatically allocate a critical, high priority, service request to the appropriate assignment group or team member?

A. User Policy

B. Ul policy

C. Predictive Intelligence
D. Assignment Rule

Answer: D

NEW QUESTION 2
- (Topic 3)

Catalog Task

|l

Save
Add to Visual Task Board

Metrics Timeline
As: Configure >

Export >
Conf View >

Create Favorite

Copy URL

Copy sys_id
Show XML
dd History >

Reload form

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table

B. The Form Context menu > Configure > Table

C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 3

- (Topic 3)

An administrator creates "customer_table_admin" and "customer_table_user" roles for the newly created "Customer Table". Which ACL rule would grant access to
all rows and all fields to both the customer_table _admin and customer_table user roles?

A. customer.all
B. customer .*
C. customer.field
D. customer.none

Answer: B

Explanation:

The customer .* ACL rule would grant access to all rows and all fields to both the customer_table_admin and customer_table_user roles because it uses a
wildcard (*) to match any operation on the customer table. The other options are either too restrictive or too broad.

Referencesl: Access control list rules - Product Documentation: Utah - ServiceNow4: Access Controls — ServiceNow Elite

NEW QUESTION 4
- (Topic 3)
Which type of scripts nun in the browser?

A. Script include Scripts
B. Business Rule Scripts
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C. Access Contra! Scripts
D. Ul Policies and Client Scripts

Answer: D

NEW QUESTION 5
- (Topic 3)
Which field (or fields) is used as a unique key during imports?

A. Match Fields

B. Coalesce Fields
C. Key Fields

D. Sys IDs

Answer: B

Explanation:
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 6
- (Topic 3)
What are advantages of using Flow Designer? (Choose three.)

A. Supports advanced developers

B. Enables complicated scripting

C. Reduces technical debt

D. Less manual scripting

E. Smooth integration with 3rd party systems

Answer: CDE

NEW QUESTION 7
- (Topic 3)
What role enables someone to authorize a request, with no other permissions on the platform?

A. Approver [approver-user]

B. Authorize [authorize-user]

C. Reviewer [reviewer_user]

D. Approver Group [approval_group]
E. Verification [verify_user]

Answer: A

NEW QUESTION 8
- (Topic 3)
What section on a task record is used to see the most recent updates made to a record?

A. Related List

B. Activity Stream
C. Audit Log

D. Timeline

Answer: B

NEW QUESTION 9
- (Topic 3)
Which tool graphically displays an infrastructure view for a configuration item (CI) and its relationship with other Cls?

A. Schema Map

B. Dependency View
C. Dependency Map
D. Database View

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/business-service-management-map-
ng/concept/c_BusinesssServiceManagementMaps.html

NEW QUESTION 10

- (Topic 3)

‘Your customer has a Human Resources knowledge base, which is only accessible to members of the Human Resources department. A new procedure regarding
employee quarterly reviews needs to be published to the quarterly review category of the HR knowledge base, but should only be visible for HR managers. How
would you meet this requirement?

A. On the Knowledge Base, add User Criteria with a Manager Can Read script to the Can Read list, publish article to any category
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B. Add User Criteria for HR Manager Group on the Category’s Can Read list
C. On the Knowledge Article, add an Access Control for HR Manager Group on the Can Read list, then publish article to any category.
D. Add User Criteria for HR Manager Group on the Can Read list of the article

Answer: B

NEW QUESTION 10
- (Topic 3)
What are examples of Core tables in the ServiceNow platform?

A. Configuration, Connect, Chat
B. Team, Party, Awards

C. User, Task, Incident

D. Work, Caller, Timecard

Answer: C

Explanation:
Reference: https://www.basicoservicenowlearning.in/2019/12/create-table-in- servicenow.html

NEW QUESTION 14
- (Topic 3)
Which framework can automatically populate values for the priority and Category field based on the Short description field value?

A. Ul Policy

B. Assignment Rule

C. Action

D. Predictive intelligence
E. CSDM

Answer: A

NEW QUESTION 19
- (Topic 3)
When importing data from a spreadsheet, which step defines where the incoming data columns will be written in the receiving table?

A. Field Matching

B. Load Data

C. Select Data Source

D. Schedule Transform
E. Create Transform Map

Answer: E

Explanation:

A transform map is a set of field maps that define the relationships between fields in an import set and fields in an existing tablel. When importing data from a
spreadsheet, creating a transform map is the step that defines where the incoming data columns will be written in the receiving table2. The transform map allows
users to specify how to transform the source data into the target data, such as by using scripts, coalescing, or mapping assist1.

References

? Transform Maps - Product Documentation: San Diego - ServiceNow1

? Importing Data: Excel to ServiceNow - Finite Partners2

NEW QUESTION 21

- (Topic 3)

A new employee joins the IT deployment and needs to perform work assigned to Network and Hardware groups. How would you set up their access?
Choose 3 answers

A. Add User Account to itll group

B. Add User Account to ACL

C. Add User Account to network group

D. Add User Account to IT Knowledgebase
E. Create User Account

F. Add User Account to Hardware group

Answer: BCF

NEW QUESTION 22
- (Topic 3)
What options can you see, when you fight click on a CI, from the Cl dependency view map? Choose 3 answers

A. View Affected Cis

B. View Related Tasks
C. View Recent Outages
D. View Cases

E. View Knowledge

Answer: ABC
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NEW QUESTION 27
- (Topic 3)
What are the components that make up a filer condition? Choose 3 answers

A. Column

B. Match Criteria
C. Field

D. Value

E. Operator

Answer: C

NEW QUESTION 30
- (Topic 3)
Which action enables personalization in a form for the admin role, only?

A. Navigate to sys_form_properties.list and set the property glide.ui.enable_personalize_form.admin to true.

B. Navigate to Context Menu > Configure > Form Layout and select 'Enable Personalization' and Enter the '‘admin’ role.
C. Navigate to Context Menu > Configure > Table and add the role '‘Admin’ in the 'Available User' list box.

D. Navigate to sys_properties.list find the property glide.ui.personalize_form.role and set the Value to admin.

Answer: D

Explanation:

This action allows only users with the admin role to personalize forms by using the Personalize Form button1. The other options are either invalid or do not restrict
personalization to the admin role only.

ReferencesPersonalize a formUI settings and personalizationPersonalization

NEW QUESTION 32
- (Topic 3)
What are the three key tables in an enterprise CMDB? Choose 3 answers.

A. omadb_rel_ci
B. sn_emdb
C.sn_emdb_ci
D. Ey omdb

E. sn_emdb_bak
F. omdb_ci

G. emdb_bak

Answer: ADF

NEW QUESTION 33
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table

B. Ensures user can get to work as quickly as possible

C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article view&sysparm_article=KB0541355

NEW QUESTION 37

- (Topic 3)

A customer has asked for the following updates to a form:

* Make Resolution code mandatory, admin state is changed to Resolved.

* Hide major incident check box, unless logged in user has Major incident Manager role.
What type of rules (s) would you use to implement this requirement?

A. Dictionary Design
B. Field Limiter

C. Ul Policy

D. Ul Design

E. Form Constraint

Answer: CE

NEW QUESTION 41
- (Topic 3)
What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances

B. Submit Default update set to application repository
C. You should not use the Default Update sets for moving between instances
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D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 45
- (Topic 3)
If a user is on an Incident form and is alerted when they change the value of the Priority field, which type of script executes in the Platform?

A. A server script
B. A client script
C. A fix script

D. A business rule

Answer: B

Explanation:

A client script is a script that runs on the client side, meaning in the user’s browser, and can manipulate the user interface or validate user inputl. A client script
can be configured to run when a form is loaded, when a field value changes, or when a form is submitted?2. In this case, the script runs when the Priority field value
changes and alerts the user.

ReferencesClient scriptsClient script types

NEW QUESTION 46
- (Topic 3)
The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response
B. Save + Update

C. Write + Read

D. Submit + Query

E. Insert + Verify

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 49
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
C. Client
D. Browser

Answer: B

Explanation:

A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.

ReferencesData policies

NEW QUESTION 54
- (Topic 3)
Which best describes a field in a SeniceNow table?

A. A field is a table cell that stores data

B. A field is a table row

C. Afield is an item that appears in a menu list
D. A field is a record in a table

Answer: C

NEW QUESTION 59

- (Topic 3)

What are the steps for importing data using an import set?

A. Select source file; Run automap; Transform data; Clean up target table
B. Set up LDAP; Test map: Create update set; Run import: Apply update set
C. Identify source; Import transform map: Run transformer; Verity import

D. Load the data; Create transform map; Transform data; Clean up import table

Answer: D
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NEW QUESTION 61
- (Topic 3)
How is a user defined in ServiceNow?

A. user is a record stored in the User Preference [Sys_user_preference] table
B. A User is a record stored in the Profile [sys_user_profile] table

C. A user is 2 field in the LOAP integration

D. A user is a record stored in the User [sys_user] table

Answer: A

NEW QUESTION 65
- (Topic 3)
When managing tags, you can adjust who is able to see iL What are the visibility options? Choose 3 answers

A. Admins

B. Everyone

C. Groups and Users

D. Roles and Permissions
E. Me

Answer: BCE

NEW QUESTION 66
- (Topic 3)
What instance resource allows you to access guided tours, information about actions, and instructions an how to use inputs and outputs in your flaw?

A. Community

B. Help Panel (question mark icon)
C. Docs

D. Wiki

Answer: B

NEW QUESTION 67
- (Topic 3)
What type of field has a drop down list, from which you can pick from pre-defined options?

A. Choice
B. Picker
C. Drop down
D. Option

Answer: A

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article view&sysparm_article=KB0538947

NEW QUESTION 71
- (Topic 3)
What type of query allows you to filter list data using normal words, instead of the condition builder?

A. Natural Language Query

B. Alexa Query

C. Machine Learning Query

D. Predictive Intelligence Query
E. Auto-suggest Query

Answer: A

NEW QUESTION 73

- (Topic 3)

What is used to determine user access to knowledge bases or a knowledge article?
A. sn_kb_read, sn_article_read

B. Privacy Settings

C. Read Access Flag

D. User Criteria

Answer: D

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 75
- (Topic 3)
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On the knowledge base record, which tab would you use to define which users are able to write articles to the knowledge base?

A. Can Read

B. Can Write

C. Can Contribute
D. Can Author

E. Cannot Author

Answer: C

NEW QUESTION 80
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon

B. Additional Actions or Context Menu
C. Hamburger icon

D. Cake icon

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 84
- (Topic 2)
On the Reports page, what sections allow you to see which reports are visible to different audiences? (Choose four.)

A. Group

B. Department
C. My reports
D. Team

E. Dashboards
F. Global

G. Admin

H. Analytics

I. All

J. Company

Answer: AEFG

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/task/t_ShareASetting.html

NEW QUESTION 89
- (Topic 3)
What is the definition of a group?

A. An escalation pod

B. A department

C. A collection of users

D. A collection of subject matter experts
E. A team of users

Answer: C

NEW QUESTION 93
- (Topic 3)
When importing data, what happens to imported rows, if no coalesce field is specified?

A. All rows are rejected from the import, as coalesce field is required.

B. All rows are treated as new record

C. No existing records are updated.

D. Duplicate rows are rejected from the import.

E. All rows are treated as new records, but errors will be flagged in the import log.

Answer: D
Explanation:

Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 95
- (Topic 3)
Which testing framework is used to test ServerNew Applications?

A. Selenium

B. Test Driven Framework (TDF)
C. Junit
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D. Automated test Framework (ATF)

Answer: D

NEW QUESTION 100
- (Topic 2)
What is the difference between a Ul Policy and Data Policy?

A. Data Policies run only after Ul Policies run successfully

B. Data Policies run regardless of how data is entered Into ServiceNow, while Ul Policies are used for form interactions

C. Data Policies can be converted into Ul Policies, but Ul Policies can not be converted into Data Policies

D. Data Policies run when data is entered through the form, by an Import Set or by web services, while Ul Policies are set only by web services

Answer: D

NEW QUESTION 101
- (Topic 2)
What are three security modules often used by the System Administrator? (Choose three.)

A. System Properties > Security

B. Utilities > Migrate Security

C. System Security > Security

D. Self-Service > My Access

E. System Security > Access Control (ACL)

F. Password Management > Security Questions
G. System Security > High Security Settings

Answer: AEG

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/reference/r_GeneralSecuritySettings.html

NEW QUESTION 105
- (Topic 2)
Which of the following is used to categorize, flag, and locate records?

A. Search

B. Favorites
C. Tags

D. Bookmarks

Answer: C

NEW QUESTION 106

- (Topic 2)

Two departments (HR Onboarding and Facilities) have come to you, asking for a way for employees to request event room set up services. The requirements are
the same for the form and the task routing to the Facilities’ assignment group.

For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation sessions.

For Facilities, the item will be used for anyone in the company who needs room set up services.

However, both departments have their own service catalogs. What do you do, to support these requirements?

A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.

C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is accessible to both HR and Facilities.

D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.

Answer: C

NEW QUESTION 111
- (Topic 2)
What feature can track the amount of time that a task has been open, to ensure that tasks are completed within an allotted time?

A. Task Escalation Clock

B. Service Level Agreements
C. Inactivity Monitor

D. Response Time Clock

E. Business Time Remaining

Answer: B

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform- administration/page/administer/task-
table/reference/r_ToolsForDrivingTasks.html#:~:text=Service%20level%20agreements%20

can%?20track,completed%20within%20an%20allotted%20time.&text=Inactivity%20monitors
%20ensure%20that%20tasks,a%20predefined%20period%200f%20time

NEW QUESTION 115
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- (Topic 2)

From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout

B. Context Menu > Configure > Form Layout
C. Context Menu > Configure > Form Design
D. Right click on header > Add > Field

E. Context Menu > Form > Designer

F. Right click on header > Configure > UX Dashboard

Answer: BD

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 116
- (Topic 2)

What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.

B. Performance Analytics can show trends; Reports cannot.

C. Reports can be run on a scheduled basis; Performance Analytics cannot.

D. Performance Analytics data can be published to Dashboards; Reports cannot.
E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 120
- (Topic 2)

Which tool should be used to populate commonly used fields in a form?

A. Template

B. Reference Qualifier
C. Formatter

D. Assignment Rule

Answer: A

NEW QUESTION 124
- (Topic 2)

What are the three permission requirements that must evaluate to true for an access control rule to apply?

Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 128
- (Topic 2)
How do you make a list filter available to everyone?

A. Make active, set visibility, and save

B. Assign a name, set visibility, and save
C. Assign a group, set visibility, and save
D. Make active, assign a name, and save

Answer: B

NEW QUESTION 130
- (Topic 2)

While showing a customer their incident form, they ask to change the Priority values to display their internal terminology P1, P2, P3, P4. They want it to be

consistent across all Tasks. How would you do that?
Right click on Priority and select what?

A. Configure Lists

B. Show Options

C. Configure Task
D. Show Choices

E. Show Choice List
F. Configure Options

Answer: F
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NEW QUESTION 134
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table

C. A group defines a set of users that share the same location

D. A group defines a set of users that share the same job title

Answer: B

NEW QUESTION 136

- (Topic 2)

Your company is giving all first line workers a special T-shirt as a recognition for their hard work. Management team wants a way for employees to order the T-
shirt, with the ability to specify the preferred size and color. How would you ensure that only first line workers (non- managers) can submit the order?

A. Create Record Producer and use the Available For list to specify First Line [sn_first_line] role
B. Create Catalog Item and use the Not Available list to specify the Manager Group

C. Create Catalog Item and use the Available For list to specify ITIL [itil] role

D. Create Order Guide and use the User Criteria list to specify First Line [sn_first_line] role

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/orlando-it-service-management/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 140
- (Topic 2)
After finishing your work on High Security Settings, what do you do to return to normal admin security levels?

A. Select Normal role

B. Log out and back in

C. Use System Administration > Normal Security module
D. Select Global Update Set

E. End Impersonation

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/concept/c_HighSecuritySettings.html

NEW QUESTION 141
- (Topic 2)
When does the Submit button appear on a form?

A. When saving an old record

B. When creating a new record

C. When changing the reference field in an existing record
D. When updating an existing record

Answer: B

NEW QUESTION 142

- (Topic 2)

You are showing your customer a new form that you have created for their new application. They would like to add a field to the form. Where could you do that?
(Choose two.)

A. Select Fields and Columns module

B. Right click on form header, select Configure > Form Layout
C. Click on context menu, select Configure > Form Designer
D. Select Field Class Manager module

Answer: BC
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 144

- (Topic 2)

When impersonating a user for testing purposes, what is the best way to return the instance, logged in with your user account?
A. Turn your computer off and on again

B. Clear browser cache

C. End Impersonation

D. Log out and back in

Answer: D
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Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/concept/c_ImpersonateAUser.html

NEW QUESTION 147
- (Topic 2)
Which of the following are not included in an Update Set, by default? (Choose four.)

. Homepages

Data

. Published Workflows
. Business Rules

. Schedules

. Database changes
. Related Lists

. Report Definitions
I. Scheduled Jobs

J. Client Scripts

K. Views

ITOMMOO®>

Answer: ABEF

Explanation:
Reference: https://docs.servicenow.com/bundle/paris-servicenow- platform/page/administer/workflow-
administration/concept/c_WorkflowMovementWithUpdateSets.html

NEW QUESTION 151
- (Topic 2)
What ServiceNow tables can Administrators define as "destinations" for imported data, when using Transform Maps in the System Import Sets application?

A. The Task table is the only table that can be a destination for imported data in the Transform Map module

B. The Inciden

C. Proble

D. Change, Task, and Service Catalog tables are the only tablesthat can be a destination for imported data m the Transform Map module
E. Only the Incident Problem, and Change tables can be a destination for imported data in the Transform Map module

F. Any ServiceNow table can be a destination for imported data in the Transform Map module

Answer: B

NEW QUESTION 152
- (Topic 2)
What controls the publishing and retiring process for knowledge articles?

A. Approval Policies
B. Approval Definitions
C. Workflow Designer
D. Workflows

E. State Lifecycle

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeWorkflows.html

NEW QUESTION 155
- (Topic 2)
What icon do you use to change the label on a Favorite?

A. Clock

B. Hamburger
C. Pencil

D. Three dots
E. Triangle.

F. Star

Answer: C

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0781451

NEW QUESTION 158
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke

B. Activate trigger security rules

C. Activate application spoke, and plug-ins as needed

D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only
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Answer: B

NEW QUESTION 163
- (Topic 2)
What kind of data can Import Sets use to populate tables in ServiceNow?

A. CSS, SOAP, and Excel
B. XM

C. CSV, and Excel

D. SOAP, REST, and XML
E. XML, SOAP, and CSS

Answer: B

Explanation:
https://docs.servicenow.com/bundle/orlando-platform-administration/page/administer/import-sets/concept/c_ImportDataUsinglmportSets.html

NEW QUESTION 168

- (Topic 2)

A change request has been approved and assigned to you as the system administrator to

change the Incident number prefix from the default of "INC" to the company standard IN." What are the next steps to be taken"

A. Go to the Number Maintenance application and change the prefix to “IN" for incident
B. Create a Business Rule that modifies the prefix before the Insert operation

C. The prefix of an incident cannot be changed because it is a built-in feature

D. Submit a Change Request to ServiceNow Technical Support

Answer: A

NEW QUESTION 173
- (Topic 2)
What is the difference between a Ul Policy and Data Policy?

A. Data Policies run when data is entered through the form, by an Import Set, or by webservices, while Ul Policies are set only by web services
B. Data Policies can be converted into Ul Policies, but Ul Policies cannot be converted into Data Policies

C. Data Policies run regardless of how data is entered into ServiceNow, while Ul Policies are used for form interactions

D. Data Policies run only after Ul Policies run successfully

Answer: C

NEW QUESTION 175
- (Topic 2)
Which section of the ServiceNow Ul allows you to perform a global search?

A. Application Navigator
B. Banner frame

C. List pane

D. Content frame

Answer: B

NEW QUESTION 179

- (Topic 2)

An IT manager is responsible for the Network and Hardware assignment groups, each group contains 5 team members. These team members are working on
many tasks, but the manager cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

= Tasks m Search Number v Search

by

5 All > Assignment group = Network.or.Assignment group = Hardware

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
B. The manager does not have the itil role.

C. The manager is not a member of the Service Desk group.

D. The manager is not a member of the Network and Hardware groups.

E. The Assignment Group manager field is empty.

Answer: C
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/task/t_CreateAGroup.html

NEW QUESTION 181
- (Topic 2)
A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this

Passing Certification Exams Made Easy visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 P QsseaQs LJ https://www.2passeasy.com/dumps/CSA/ (371 New Questions)

issue?

A. Have them clear their cache.

B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.

D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 182
- (Topic 2)
When designing a flow, how do you reference data from a record, in that flow?

A. Drag the table icon onto the flow definition

B. Use the condition builder to specify the desired values
C. Specify the source table on the data pill related list

D. Drag the data pill onto the flow definition

E. Add the table reference using the slush bucket

Answer: D

Explanation:

Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/paris/citizen_developer/app_store_learnv2_flowdesigner_paris_using_flow_variables

NEW QUESTION 186
- (Topic 2)

Which feature allows you to automate business logic for a particular application or process such as approvals, tasks notifications, and record operations?

A. Flows

B. Action Sequences
C. Action Sets

D. Task Flows

E. Flow Diagrams

Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/flow-
designer.html#:~:text=the%20following%20components%3A-,Flows,a%20particular¥%20application%200r%20process

NEW QUESTION 190
- (Topic 2)
In addition to the admin role, which one of the following roles allows a user to add or remove fields from a list?

A. personal ize.control
B. personal_list

C. ul_page_admin

D. ui_action_admin

Answer: A

NEW QUESTION 193
- (Topic 1)
When searching using the App Navigator search field, what can be returned? (Choose four.)

A. Names of Applications and Modules
B. Names of Modules

C. Names of Applications

D. Favorites

E. History Records

F. Titles of Dashboard Gauges

Answer: ABCD

NEW QUESTION 195

- (Topic 2)

What import utility do you use when the field names on the import set match the name of the fields on the Target table?
A. Schema Mapping

B. Automatic Mapping

C. Mapping Assist

D. Mapping Dashboard

Answer:
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B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/script/server-scripting/concept/c_MappingOptions.html

NEW QUESTION 200
- (Topic 2)
What function do you use to add buttons, links, and context menu items on forms and lists?

A. Ul Policies
B. Ul Settings
C. Ul Actions
D. Ul Config

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/concept/c_UIlActions.html

NEW QUESTION 201
- (Topic 1)
What are the 5 provided Roles by ServiceNow?

A. System Administrator: The admin role provides access to all platform features, applications, functions and data.

B. Specialized Administrator: Specialized administrator roles manage specific functions or applications, such as Assignment Rules, Knowledge base, reports, or
web services

C. Fulfiller: Users with the ITIL role may fulfill ITIL activities associated with the ITIL workflow, including Incident and Change management.

D. Approver: Users with the Approver user role can perform all requester actions and may view or modify approval records directed to the approver

E. Requester: Also known as Employee Self Service (ESS) users, these users have no roles but can submit and manage their own requests, access public pages,
etc.

Answer: ABCDE

NEW QUESTION 204
- (Topic 1)
A knowledge article must be which of the following states to display to a user?

A. Published
B. Drafted
C. Retired
D. Reviewed

Answer: A

NEW QUESTION 206
- (Topic 1)
Which of the following concepts are associated with the ServiceNow CMDB? (Choose four.)

A. Service Processes

B. User Permissions

C. Tables and Fields

D. A Database

E. The Dependency View

Answer: ACDE

NEW QUESTION 208
- (Topic 1)
What are the two pathways to view feedback left on a published article?

A. Knowledge > articles > My Flagged

B. Knowledge base > my knowledge > flagged articles
C. Knowledge > My articles > Flagged

D. Knowledge > articles > published

Answer: AD

NEW QUESTION 212

- (Topic 1)

What is a way that you can mark a knowledge article for review?
A. Flag article

B. Review

C. Bookmark

D. On Hold

Answer:
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A

NEW QUESTION 213
- (Topic 1)
What module in the Service Catalog application does an Administrator access to begin creating a new item?

A. Maintain Categories
B. Maintain Items

C. Content Iltems

D. ltems

Answer: B

NEW QUESTION 217
- (Topic 1)
Which of the following statements is true when a new table is created by extending another table?

A. The new table archives the parent table and assumed its roles in the database

B. The new table inherits all of the Business Rules, Client Scripts, and Ul Policies of the parent table, but none of the existing fields
C. The new table inherits all of the fields of the parent table and can also contain new fields unique to itself

D. The new table inherits all of the fields, but does not inherit Access Control rules, Client Scripts, and Ul Policies of the parent table

Answer: C

NEW QUESTION 218
- (Topic 1)
What is generated from the Service Catalog once a user places an order for an item or service?

A. A change request
B. An Order Guide
C. Arequest

D. An SLA

Answer: C

NEW QUESTION 220
- (Topic 1)
Knowledge articles within a knowledge base are grouped by category.

A. True
B. False

Answer: A

NEW QUESTION 221
- (Topic 1)
Configuration will not affect what others see on their forms.

A. True
B. False

Answer: B

NEW QUESTION 225
- (Topic 1)
What displays a set of records from a table?

A. View

B. Dashboard
C. Panel

D. List

Answer: D

NEW QUESTION 226

- (Topic 1)

What is the name of the conversational bot platform that provides assistance to help users obtain information, make decisions, and perform common tasks?
A. Agent

B. live Feed

C. Virtual Agent

D. Connect Chat

Answer: C
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NEW QUESTION 230
- (Topic 1)
Which configuration allows you to use a script to coalesce data in Import Sets?

A. Multiple-field coalesce
B. No coalesce

C. Conditional coalesce
D. Single-field coalesce

Answer: C

NEW QUESTION 235
- (Topic 1)
What is a Dictionary Override?

A. A Dictionary Override is an incoming customer update in an Update Set which applies to the same objects as a newer local customer update
B. A Dictionary Override is the addition, modification, or removal of anything that could have an effect on IT services

C. A Dictionary Override is a task within a workflow that requests an action before the workflow can continue

D. A Dictionary Override sets field properties in extended tables

Answer: D

NEW QUESTION 237
- (Topic 1)
Which one of the following statements describes the contents of the Configuration Management Database (CMDB)?

A. The CMDB contains data about tangible and intangible business assets

B. The CMDB contains the Business Rules that direct the intangible, configurable assets used by a company
C. The CMDB archives all Service Management PaaS equipment metadata and usage statistics

D. The CMDB contains ITIL process data pertaining to configuration items

Answer: A

NEW QUESTION 238
- (Topic 1)
What is a Record Producer?

A. A Record Producer is a type of Catalog Item that is used for Requests, not Services

B. A Record Producer creates user records

C. A Record Producer is a type of Catalog Item that provides easy ordering by bundling requests

D. A Record Producer is a type of a Catalog Item that allows users to create task-based records from the Service Catalog

Answer: D

NEW QUESTION 241
- (Topic 1)
Ul Policy can make fields read-only, mandatory, or hidden.

A. True
B. False

Answer: A

NEW QUESTION 245
- (Topic 1)
Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?

A. Form

B. List

C. Dashboard
D. Timeline

Answer: C

NEW QUESTION 246

- (Topic 1)

As it relates to ServiceNow reporting, which of the following statements describes what a metric can do?
A. A metric is a report gauge used on homepages to display real-time data

B. A metric is a time measurement used to report the effectiveness of workflows and SLAs

C. A metric is used to measure and evaluate the effectiveness of IT service management processes

D. A metric is a comparative measurement used to report the effectiveness of workflows and SLAs.

Answer: C
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NEW QUESTION 251
- (Topic 1)
Which technique is used to get information from a series of referenced fields from different tables?

A. Table-Walking
B. Sys_ID Pulling
C. Dot-Walking

D. Record-Hopping

Answer: C

NEW QUESTION 256
- (Topic 1)
ServiceNow uses what term to describe all the data saved within a particular form?

A. Fields
B. Form
C. Record
D. Lists

Answer: C

NEW QUESTION 261
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.

D. They provide options.

Answer: B

NEW QUESTION 264
- (Topic 1)
In what order should filter elements be specified?

A. Field, Operator, then Value

B. Field, Operator, then Condition
C. Operator, Condition, then Value
D. Value, Operator, then Field

Answer: A

NEW QUESTION 269
- (Topic 1)
How are Workflows moved between instances?

A. Workflows are moved using Update Sets

B. Workflows are moved using Transform Maps

C. Workflows are moved using Application Sets

D. Workflows cannot be moved between instances

Answer: A

NEW QUESTION 272
- (Topic 1)
What is the master table that contains a record for each table in the database?

A. [sys_master_db]
B. [sys_db_object]
C. [sys_master_object]
D. [sys_object_db]

Answer: B

NEW QUESTION 274

- (Topic 1)

Which three Variable Types can be added to a Service Catalog Item?
A. True/False, Multiple Choice, and Ordered

B. True/False, Checkbox, and Number List

C. Number List, Single Line Text, and Reference

D. Multiple Choice, Select Box, and Checkbox

Answer: D

Passing Certification Exams Made Easy

visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 PQSS@QSLJ https://www.2passeasy.com/dumps/CSA/ (371 New Questions)

NEW QUESTION 276
- (Topic 1)
A REQ number in the Service Catalog represents...

A. the order number.

B. the stage.

C. the task to complete.

D. the individual item in the order.

Answer: A

NEW QUESTION 281
- (Topic 1)
For Administrators creating new Service Catalog items, what is a characteristic they should know about Service Catalog variables?

A. Service Catalog variables can only be used in Record Producers
B. Service Catalog variables can only be used in Order Guides

C. Service Catalog variables cannot affect the order price

D. Service Catalog variables are global by default

Answer: D

NEW QUESTION 282
- (Topic 1)
Which one statement correctly describes Access Control rule evaluation?

A. Rules are evaluated using role

B. The role with the most permissions evaluates the rules first

C. If more than one rule applies to a row, the older rule is evaluated first

D. If a row level rule and a field level rule exist, both rules must be true before an operation is allowed
E. Rules are evaluated from the general to the specific, so a table rule must be active to continue

Answer: D

NEW QUESTION 287
- (Topic 1)
Data Policy can enforce mandatory data on import.

A. True
B. False

Answer: A

NEW QUESTION 292
FILL IN THE BLANK - (Topic 1)
FILL IN THE BLANK
is a computer program running as a service; a physical computer dedicated to running one or more services, or a system running a database.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Server

NEW QUESTION 297
- (Topic 1)
What are the two aspects to LDAP Integration?

A. Data Population
B. Data formatting
C. Authorization
D. Authentication

Answer: AD

NEW QUESTION 301
- (Topic 1)
A Service Catalog may include which of the following components?

A. Order Guides, Exchange Rates, Calendars

B. Order Guides, Catalog Items, and Interceptors

C. Catalog Items, Asset Contracts, Task Surveys

D. Record Producers, Order Guides, and Catalog Items
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Answer: D

NEW QUESTION 306

- (Topic 3)

What process allows users to create, categorize, review approve and browse important information in a centralized location that is shared oy the entire
organization?

A. Self Service Management

B. Knowledge Management

C. Knowledge-Centered Management
D. Information Portal Management

E. Business Information Management

Answer: B

Explanation:

Knowledge Management is the process that allows users to create, categorize, review, approve and browse important information in a centralized location that is
shared by the entire organizationl. Knowledge Management helps users to find relevant and accurate information quickly, reduce the need to rediscover
knowledge, and improve the quality of service and customer satisfactionl.

References
? Knowledge Management - ServiceNow1

NEW QUESTION 310
- (Topic 3)
Which role(s) are required to impersonate a user? Choose 2 answers

..admin

. Sys_admin

. security_admin
. Sys_user

. impersonator

moO o>

Answer: AE

Explanation:

The admin role is required to impersonate any user in ServiceNow, while the impersonator role is required to impersonate a user who has granted impersonation
access to the impersonator. The other roles are not related to the impersonation functionality. Referencesl: Impersonate a user - Product Documentation: San
Diego - ServiceNow2: Non-admin users with the “impersonator” role cannot impersonate any user if there are orphaned ‘sys_user_has_role’ records like " [user:
null; role: admin]". - Support and Troubleshooting - ServiceNow

NEW QUESTION 312
- (Topic 3)
What ServiceNow feature allows you to include data from a secondary related table on a report?

A. SQL

B. Dot Walking
C. Outer Join
D. Joins

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/concept/c_ HowToAccessRelatedTables.html

NEW QUESTION 316
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category

B. On the Filter Menu, select Group By > Category

C. Click Group On icon, select Category

D. On Navigator Filter, type tablename.group.category and press enter

E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 317
- (Topic 3)
How would you define an Access Control, to allow a user with iti role to have permission to create incident records?

A. Name: incident”; Permission: write; Role: itil

B. Name: incident Any, Operation: write, Permission: itil
C. Name: incident.*; Operation: write; Permission: itil
D. Name: incident None, Permission: create: Role: itil
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E. Name: inciden
F. None; Operation: create; Role: itil

Answer: D

NEW QUESTION 320
- (Topic 3)

What setting allows users to view a Knowledge Base article even if the are not logged in?

A. The View All setting
B. The Allow role

C. The ESS role

D. The Public setting

Answer: C

NEW QUESTION 323
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map

B. Schema Map

C. Tables

D. Flow Design

E. Dependency View

Answer: E

Explanation:

The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how Cls are

connected and how changes to one Cl may impact others.
References:

? ServiceNow Product Documentation: Configuration item relationships in the CMDB

- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html

? ServiceNow Community: How to display dependencies for Cls in the Dependency
View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 327
- (Topic 3)

While on an Incident record, how would you add a Tag for "Special Handling" to the record?

A. Click on the More options (.,.) icon, click Add Tag, type Special Handling, press enter

B. On the Special Handling field, check the box
C. On the Tag field, select Special Handling from the choice list

D. Click on the Context menu, select Add Tag, type Special Handling, press enter

Answer: A

NEW QUESTION 328
- (Topic 3)
What does Natural Language Query allow you to do on a list?

A. Automatically select a filter, based on keywords
B. Filter list by typing in a phrase

C. Predict the filter desired by the user

D. Speak to the condition builder

E. Set list filter, using audible commands

Answer: A

NEW QUESTION 332
- (Topic 3)
Which admin role is required to make changes to High Security Settings?

A. security _admin
B. sn_ad_admin

C. high_sec_admin
D. admin

Answer: A

NEW QUESTION 337

- (Topic 3)

What are examples of Ul Actions, relating to Lists? Choose 4 answers

A. List Links
B. List Control
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C. List Buttons
D. List Context Menu
E. List Override
F. List Choices

Answer: ACDF

NEW QUESTION 341
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the natification

B. The associated knowledge base

C. Under what conditions is the notification sent
D. Who receives the notification

E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 345
- (Topic 3)

Servicenodw Al Favorites  Admin

¢ | = Incident
New record

You are editing a new incident record and would like the Save" Dutton to be located on the Form header. Which action would need to be taken for that button to
appear?

A. All > System Properties > Ul Properties > Turn on the glide.ui.advanced* property
B. Context Menu > Form Design > add the Save" button

C. All > System Properties > Ul Properties > Turn on the Save" button

D. Context Menu > Form Layout > add the Save* button.

Answer: C

Explanation:

To add the Save button to the form header, users need to turn on the system property glide.ui.save_button, which enables the Save button on all forms1. Users
can navigate to All > System Properties > Ul Properties and search for the property name, then set the value to truel. Alternatively, users can use the
sys_properties.list URL suffix and filter by the property namel.

References

? How to add or enable Save Button on all the forms across a Servicenow Instance - Support and Troubleshooting - Now Support Portal

NEW QUESTION 349
- (Topic 3)
Which feature can be used to categorize a set of records from a list and make them visible to other users?

A. Tags

B. History

C. Favorites

D. Activity Formatter

Answer: A

Explanation:

Tags are labels that you can apply to any task record in ServiceNow. You can use tags to categorize, filter, and search records. You can also share tags with
other users to make them visible to others1.

ReferencesUsing tags

NEW QUESTION 350
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.

B. Use extremely large Import Sets, instead of multiple large Import Sets.

C. Create a new Import set table for each new data load.

D. Plan time before your import to remove obsolete or inaccurate data.

E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D
Explanation:

This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.
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Referenceslmport and export resources page

NEW QUESTION 355

- (Topic 3)

When would you use the following steps?
* 1, Homepage Admin > Pages

* 2. Right click on Homepage record

* 3. Select Unioad Portal Page

A. To publish a Homepage to the Portal

B. To retire a Homepage

C. To delete a Homepage

D. o To add a Homepage to an update set

Answer: D

NEW QUESTION 357
- (Topic 3)
What resource can you use to view details of the tables and configuration items (CIs) associated with a particular use case?

A. Scenario Dashboard

B. Cl Use Case Modeler

C. CMDB Use Case Modeler

D. Common Service Data Model (CSDM) product view

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html

NEW QUESTION 361

- (Topic 3)

What features are available in Knowledge Management, to support continuous improvement on the knowledge articles?
Choose 4 answers

A. Submit KB Errata

B. Add Comments

C. CC Click frowning icon
D. Tag as Helpful

E. Flag Article

F. Rate with Stars

Answer: BDEF

NEW QUESTION 365
- (Topic 3)
If a knowledge base has no access details specified, what users are able to read articles in that knowledge base?

A. itil users

B. Any user with an article's permalink
C. Any active user

D. No users

E. Users with kb_user role

Answer: C

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0623654

NEW QUESTION 367
- (Topic 3)
On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute

B. Label

C. Field

D. Column

E. Data Element

Answer: C

NEW QUESTION 372

- (Topic 3)

Which module would you use to customize your instances banner image, text and colors?

A Homepage Admin > Pages > Branding

A. System Ul > Ul Pages > Branding
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B. System Properties > Branding
C. System Properties > Basic Configuration Ul16
D. Service Portal > Portals > Branding

Answer: D

NEW QUESTION 374
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